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vi 
Introduction
We are pleased to present you with the latest version of HYSYS-the 
product that is continually extending the boundaries of process 
engineering software. HYSYS is part of the Aspen Engineering Suite 
(AES), a set of software tools designed to help manage process 
knowledge throughout the asset lifecycle. HYSYS is a major part of the 
Simulation and Optimization family of products that forms the 
foundation of AES.

The Aspen Engineering Suite (AES)
There is huge opportunity in successfully managing the process 
industry challenges through optimal Process Asset Lifecycle 
Management (PaLM) from Business Planning & Economic Analysis, to 
R&D and Conceptual Design, to Process Engineering, to Detailed 
Engineering, to Technology Transfer & Construction, and throughout to 
Operations.

AES is AspenTech’s Process Asset Lifecycle Management solution that 
enables optimal and consistent decisions to be made through the use of 
consistent data and models. AES consists of integrated products, 
enabling the execution of various PaLM tasks throughout the enterprise:

• AES Economic Evaluation products combine engineering and 
business decisions for accurate project scope definition and cost 
evaluation, from conceptual project definition through detailed 
engineering. 

• AES Collaborative Engineering products support integrated 
collaborative engineering to create a Frond End Engineering 
Design (FEED) package and share process engineering 
expertise.

 Figure 1
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• AES Physical Properties & Chemistries products include 
physical property data, models, estimation and regression 
capabilities adapted for the Oil & Gas, Refining, Chemicals, and 
Pharmaceuticals industries.

• AES Conceptual Engineering products assist process 
engineers in creating, identifying and selecting best process 
designs for heat exchangers networks and separation trains.

• AES Simulation and Optimization products enable engineers to 
quickly identify optimal plant designs for steady state and 
dynamic simulation and optimization as well as for batch process 
and recipe development. These products enable to optimize plant 
designs, establish heat and material balances, support 
environmental and safety studies, and to carry out operability 
analysis.

• AES Equipment Design and Rating products support the design 
and rating of highly performing heat exchangers with minimum 
capital cost.

AES is an open environment that supports and promotes open industry 
standards such as CAPE-OPEN, OPC, ASME, CODAP, PD5500, DIN, JIS, 
TEMA.

HYSYS
HYSYS is a process simulation environment designed to serve many 
processing industries especially Oil & Gas and Refining.   With HYSYS, 
you can create rigorous steady state and dynamic models for plant 
design, performance monitoring, troubleshooting, operational 
improvement, business planning and asset management. Through the 
completely interactive HYSYS interface, you can easily manipulate 
process variables and unit operation topology, as well as fully customize 
your simulation using its customization and extensibility capabilities.

The HYSYS environment has been developed with an overall vision of 
the ultimate process simulation solution in mind. This vision has led us 
to create a product that is interactive, intuitive, open, extensible and 
integrated with the products in the AES. HYSYS also has many add on 
options to extend it’s capabilities into specific industries or into other 
aspects of PaLM. 
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The set of HYSYS related products and options: 

HYSYS, an interactive and integrated modeling environment

Product Capabilities

HYSYS Steady State Process Simulation with HYSYS

Provides the accuracy, speed, and efficiency required for 
process design activities. The level of detail and the 
integrated utilities available in HYSYS allow for skillful 
evaluation of design alternatives, with fast and efficient 
process simulation. A wide range of thermodynamics and 
unit operations together with standard links to Windows 
packages makes HYSYS the most complete steady state 
process simulation tool.

HYSYS Dynamics 
Option

Plant Operability, Design and Management with the 
HYSYS Dynamics option.

The HYSYS option provides a dynamic simulation 
capability fully integrated with the HYSYS environment, a 
steady state model can be leveraged into a dynamic 
model which offers rigorous and high-fidelity results with a 
very fine level of equipment geometry and performance 
detail. Evaluate dynamic plant behaviour, controllability, 
start up and shut down scenarios from the same base 
model used in steady state process design. With a 
consistent look and feel, links to APC software, hydraulic 
applications, and other third-party applications, HYSYS 
provides a complete platform for dynamic process 
simulation.

HYSYS Upstream Option The Upstream option enables HYSYS as a powerful 
design, operations and planning tool for the Upstream Oil 
and Gas industry. 

Complete with Black Oils and PVT Analysis, this option 
allows HYSYS to speak the thermodynamic language of 
the Upstream. Transition from Black Oil to a full 
compositional mode is possible when more accuracy is 
required. Together with Aspen Hydraulics, for well and 
flowline integration, HYSYS has become the only 
modeling environment to complete the entire upstream 
asset model from sandface to transmission.

HYSYS Amines Option The Amines option is specifically designed for acid gas 
treating using amines, blended amines and physical 
solvents. 

The Amines option is based on the AMSIM technology 
developed by DBR Associates, a division of 
Schlumberger. The Amines option is a unique property 
package developed specifically for acid gas treating 
processes involving amines, blended amines and physical 
solvents. The Amines option utilizes the most up to date 
thermodynamics models and is validated against plant 
data. 
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HYSYS Crude Option The Crude option is used to accurately characterize crude 
oils from laboratory assay data.

The HYSYS Crude Option gives the user the choice of 5 
different assay laboratory analyses standards used in the 
Oil industry. Using the standard laboratory data input 
along with the most recent correlation methods, the 
HYSYS Crude option will determine the hypothetical 
components that make up the Oil and predict their 
thermophysical and transport properties.

HYSYS OLI Interface An add-on option to HYSYS specifically designed for 
modeling aqueous systems.

The HYSYS OLI Interface option is based on technology 
developed by OLI Systems Inv, experts in aqueous 
chemistry. The OLI thermodynamic models and engine 
are seamlessly integrated into HYSYS so that virtually any 
water based system can be accurately simulated in the 
HYSYS environment.

Virtual Plant Simulator Operator Training Services with HYSYS Virtual Plant 
Simulator project services. 

HYSYS Virtual Plant Simulator services provides real-time 
simulated training exercises that train operations 
personnel and help develop their skills performing critical 
process operations. Increased process understanding and 
procedural familiarity for operations personnel can lead to 
increased plant safety and improved process 
performance. The Virtual Plant Simulator is powered by 
the same HYSYS models used by the Engineering and 
Process Control Departments but with DCS emulation, 
look, and feel. HYSYS extends the model’s use into the 
Operations Departments.

HYSYS Optimizer & Data 
Reconciliation

Online and Offline Optimization with the Optimizer and 
Data Reconciliation Options in HYSYS.

HYSYS provides tools for on or offline performance 
monitoring and optimization. These Options enables the 
optimization of plant efficiency and the management of 
production rate changes and upsets in order to handle 
process constraints and maximize operating profits. Using 
SQP Optimization techniques, constraint handling and 
data reconciliation with the HYSYS simulation providing 
the predictive capability this creates a powerful tool for 
operations improvement.

HYSYS, an interactive and integrated modeling environment

Product Capabilities
ix
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Intuitive & Interactive Process 
Modeling
AspenTech believes that the role of process simulation is to improve 
your process understanding so that you can make the best process 
decisions. This solution has been, and continues to be, interactive 
simulation. This has not only proven to be the most efficient use of your 
simulation time, but by building the model interactively with immediate 
access to results you gain the most complete understanding of your 
simulation. 

HYSYS uses the power of object oriented design, together with an event-
driven graphical environment, to deliver a completely interactive 
simulation environment where:

• calculations begin automatically whenever you supply new 
information, and

• access to the information you need is not restricted.

At any time, even as calculations are proceeding, you can access 
information from any location in HYSYS. As new information becomes 
available, each location is always instantly updated with the most 
current information, whether specified by you or calculated by HYSYS.

Open & Extensible HYSYS Architecture 
The Integrated Simulation Environment and our fully object oriented 
software design has paved the way for HYSYS to be fully Active X 
compliant, allowing for complete user customization. Through a 
completely transparent interface, OLE extensibility lets you:

• develop custom steady state and dynamic unit operations.
• specify proprietary reaction kinetic expressions.
• create specialized property packages.
x
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With seamless integration, new modules appear and perform like 
standard operations, reaction expressions or property packages within 
HYSYS. The Automation features within HYSYS expose many of the 
internal objects to other Active X compliant software like Microsoft 
Excel, Visual Basic, and Visio. This functionality enables you to create 
custom applications that utilize HYSYS unique capabilities or link it to 
your own in-house applications.

By using industry standard Active X Automation and Extensibility, the 
custom simulation functionality is portable across AspenTech software 
updates. The open architecture allows you to extend your simulation 
functionality in response to your changing needs.

Integration with AES
HYSYS is now integrated with many products of the AES to enhance 
Process Asset Lifecycle Management. These include:

Aspen WebModels

HYSYS models can be authored and published over the intranet/
internet through integration with Aspen WebModels from within the 
HYSYS simulation environment. Aspen Webmodels is an excellent tool 
for distributing the power of simulation models to non expert users. 

Aspen Enterprise Engineering

HYSYS can be run under the Aspen Enterprise Engineering platform, 
AEE. AEE is a Citrix based system for deploying the Aspen Engineering 
Suite within an organization. Using AEE, HYSYS is installed on a server 
through which users access the software. No local installations on user 
desktops are necessary
xi
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Aspen OnLine

HYSYS models can be connected to live plant information systems 
through Aspen OnLine. Aspen OnLine uses CIMIO to connect to 
numerous Plant Information and DCS Systems including Aspen’s IP21. 
The ability to connect HYSYS simulation models to live plant data 
enables high value activities such as Performance Monitoring, Soft 
Sensors, Safety Surveillance and Optimization

Aspen Custom Modeler

Aspen Custom Modeler is the easy to use custom modeling 
environment for the Aspen Engineering Suite. Custom user models built 
in ACM can be exported to the HYSYS simulation environment and run 
in both Steady State and Dynamics. This addition gives HYSYS yet 
another means to customize and extend HYSYS simulation models to 
meet your specific simulation needs.

Aspen DMC+

Aspen’s Advance Process Controller, DMC+, has been integrated with 
HYSYS Dynamics. This integration provides a unique tool to the world 
of advanced control. Configuring an Advanced Control mechanism 
typically requires step tests to be performed on the physical plant. These 
step tests take the plant off production until the APC model is 
configured. The advanced control algorithm can be tested and validated 
on a HYSYS model before costly step tests are performed on the plant. 
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HTFS

HYSYS users have a rigorous option for design of heat transfer 
equipment through the integration with the HTFS family of heat 
exchanger equipment products. TASC, for shell and tube exchangers, 
MUSE for multi-pass exchangers and ACOL, for air coolers are all 
accessible through the appropriate HYSYS unit operation. This gives the 
user a powerful tool when more rigor is required in modeling the heat 
transfer equipment without ever leaving the HYSYS environment. 

Aspen Icarus

HYSYS simulation models can be exported to Aspen Icarus IPE or IPM 
for economic evaluation of process designs. Aspen Icarus performs unit 
operation and site wide costing of processing equipment and facilities.

Aspen Zyqad

HYSYS simulation models can be exported to Aspen Zyqad in order to 
streamline the front-end engineering work process. Using Zyqad 
throughout this process results in increased engineering efficiency, 
quality and reduced project cycle time.
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Use of the Manuals
HYSYS Electronic Documentation
All HYSYS documentation is available in electronic format as part of the 
HYSYS Documentation Suite. The HYSYS Documentation CD-ROM is 
included with your HYSYS package. The content of each manual is 
described in the following table:     

If you are new to HYSYS, you may want to begin by completing one or 
more of the HYSYS tutorials, which give step-by-step instructions for 
building a simulation case. If you have some HYSYS experience, but 
would still like to work through some more advanced sample problems, 
refer to the HYSYS Applications.

The HYSYS Documentation 
Suite includes all available 
documentation for the HYSYS 
family of products.

Manual  Description

Installation Guide Introduces you to HYSYS, explains how to install HYSYS, and discusses style 
conventions used in the manuals. Sample steady state and dynamics cases are included 
to teach you how to navigate through HYSYS.

User Guide Provides in-depth information on the HYSYS interface and architecture, and guides you 
through all aspects of HYSYS.

Simulation Basis Contains all information relating to the available HYSYS fluid packages and components. 
This includes information on the Oil Manager, Hypotheticals, Reactions as well as a 
thermodynamics reference section.

Operations Guide Contains information on building and running HYSYS simulations in steady state and 
dynamic mode. Unit operations and utilities are covered in depth.

Dynamic Modeling Contains information on dynamic theory and controls theory.

Customization Guide Details the many customization tools available in HYSYS. Information on enhancing the 
functionality of HYSYS by either using third-party tools to programmatically run HYSYS 
(Automation), or by the addition of user-defined Extensions is covered. Other topics 
include the current internally extensible tools available in HYSYS: the User Unit 
Operation and User Variables as well as comprehensive instruction on using the HYSYS 
View Editor.

Upstream Option Guide Contains information on the Black Oil, Infochem Multiflash, Lumper, Delumper, PIPESIM 
Link and PIPESIM NET.

Tutorials & Applications The Tutorials section provides step-by-step instructions for building industry-specific 
simulation examples. The Applications section contains more advanced example 
problems. Before you use this manual, you should have a good working knowledge of 
HYSYS (from the Tutorials. The Applications do not provide many of the basic 
instructions at the level of detail given in the Tutorials.

Contact your AspenTech agent 
for information on HYSYS 
training courses, or e-mail us at 
training@aspentech.com.
xiv
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Since HYSYS is totally interactive, it provides virtually unlimited 
flexibility in solving any simulation problem. Keep in mind that the 
approach used in solving each example problem presented in the 
HYSYS documentation may only be one of the many possible methods.

Viewing the Online Documentation
HYSYS online documentation is viewed using Adobe Acrobat Reader®, 
which is included on the Documentation CD. Install Acrobat Reader on 
your computer following the instructions on the CD insert card. Once 
installed, you can view the electronic documentation either directly 
from the CD, or you can copy the Doc folder (containing all the 
electronic documentation files) and the file named Menu.pdf to your 
hard drive before viewing the files. (Be certain to move these files 
together, otherwise all the links will not work properly.)

Manoeuvre through the online documentation using the bookmarks on 
the left of the screen, the navigation buttons in the toolbar or using the 
scroll bars on the side of the view. Bold blue text indicates an active link 
to a referenced section or view; click on the link and Acrobat Reader will 
jump to that particular section.

Selecting the Search Index
One of the advantages in using the HYSYS Documentation CD is the 
ability to do power searching using the Acrobat search tools. The 
Acrobat Search command allows you to perform full text searches of 
PDF documents that have been indexed using Acrobat Catalog®.

To attach the index file to Acrobat Reader 5.0.5, use the following 
procedure: 

1. Open the Index Selection view by selecting Edit-Search-Select 
Indexes from the menu.

2. Click the Add button. The Add Index view appears.

Ensure that your version of 
Acrobat Reader has the 
Search plug-in present. This 
plug-in allows you to add a 
search index to the search list. 

For more information on the 
search tools available in 
Acrobat Reader, consult the 
help files provided with the 
program.
xv
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3. Ensure that the Look in field is currently set to your CD-ROM drive. 
There should be two folders visible from the root directory: Acrobat 
and Doc as shown below.    

4. Open the Doc folder. Inside it you should find the Index.pdx file. 
Select it and click the Open button.

5. The Index Selection view shows the available indexes that can be 
attached. Select the index name and then click the OK button. You 
may now begin making use of the Acrobat Search command.

 Figure 2

 Figure 3
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Using the Search Command
The Acrobat Search command allows you to perform a search on PDF 
documents. You can search for a simple word or phrase, or you can 
expand your search by using wild-card characters and operators. 

To search an index, first select the indexes to search and define a search 
query. A search query is an expression made up of text and other items 
to define the information you want to define. Next, select the 
documents to review from those returned by the search, and then view 
the occurrences of the search term within the document you selected. 

To perform a full-text search do the following:

1. Choose Edit-Search-Query from the menu.

2. Type the text you want to search for in the Find Results Containing 
Text box.

3. Click Search. The Search view is hidden, and documents that match 
your search query are listed in the Search Results window in order of 
relevancy.

4. Double-click a document that seems likely to contain the relevant 
information, probably the first document in the list. The document 
opens on the first match for the text you typed.

5. Click the Search Next button or Search Previous button to go to 
other matches in the document. Or choose another document to 
view.

You can also use the Find tool (CTRL F). This is a less powerful method of 
searching but can still be useful. Other Acrobat Reader features include 
a zoom-in tool in the toolbar, which allows you to magnify the text you 
are reading. You can print pages or chapters of the online 
documentation using the Print command under the File menu. 

Wild card characters:

* and ?

Operators:

= exact match

~ contains

! does not contain

Boolean Operators:

NOT exclude

AND

Use quotes “ “ for a literal 
search.
xvii
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Conventions Used in the Manuals
The following section lists a number of conventions used throughout 
the documentation.

Keywords for Mouse Actions

As you work through various procedures in the manuals, you will be 
given instructions on performing specific functions or commands. 
Instead of repeating certain phrases for mouse instructions, keywords 
are used to imply a longer instructional phrase:

Keyword Action

Point Move the mouse pointer to position it over an item. For example, 
point to an item to see its Fly-by information.

Click Position the mouse pointer over the item, and rapidly press and 
release the left mouse button. For example, click the Close icon 
to close the current view.

Right-Click Same as click, but use the right mouse button. For example, 
right-click an object to display the Object Inspection menu.

Double-Click Position the mouse pointer over the item, then rapidly press and 
release the left mouse button twice. For example, double-click 
the HYSYS icon to launch the program.

Drag Position the mouse pointer over the item, press and hold the left 
mouse button, move the mouse while the mouse button is down, 
and then release the mouse button. For example, you drag items 
in the PFD to position them.

Fly-by Information Whenever you pass the mouse pointer over certain objects, such 
as toolbar icons and flowsheet objects, a small yellow box with 
text appears. It contains a brief description of the action that will 
occur if you click on that button or details relating to the object.
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Selecting Items

Selecting refers to either picking a specific item from a list, or invoking a 
button command. There are three types of selecting in HYSYS: 

A number of text formatting conventions are also used throughout the 
manuals:

Method Description

Selecting a cell Move the mouse to the location and left-click to select.

Selecting from a drop 
down menu or list

Move the focus location into the drop-down, and use the 
mouse pointer or keyboard arrows to highlight the selection, 
then press ENTER to select.

Multiple list selections Click and drag the mouse over the items you want to select 
(provided they are all sequential in the list). Alternatively, you 
can highlight sequential items by selecting the first item in 
the list, holding down the SHIFT key and selecting the last 
item in the list. If the items are not sequential, select the first 
item with the left mouse button and then select additional 
items with the mouse while holding down the CTRL key.

Format Example

When you are asked to access a menu command, 
the command is identified by bold lettering.

Select File-Save from the menu 
to save your case.

When you are asked to click a button, the button is 
identified by bold lettering.

Click the Close button to close 
the current view.

When you are asked to press a key or key 
combination to perform a certain function, keyboard 
commands are identified by words in bolded small 
capitals (small caps).

Press F1 to open the context 
sensitive help.

The name of a HYSYS view (also know as a property 
view) is indicated by initial capitalization.

The Session Preferences view 
appears.

The names of pages and tabs on various views are 
identified in bold lettering when an action is being 
performed on these pages or tabs. If there is no 
direct action on that particular page or tab, then it is 
NOT bolded.

Click Composition page on the 
Worksheet tab to see all the 
stream composition information.

The names of radio buttons, checkboxes and cells 
are identified by initial capitalization.

Click the Ignored checkbox to 
ignore this operation.

Material and energy stream names are identified by 
initial capitalization.

Double-click on the Column 
Feed stream to open its view.

Unit operation names are identified by initial 
capitalization. 

Click on the Inlet Separator to 
highlight it.

When you are asked to provide keyboard input, it will 
be indicated by bold lettering accompanied by words 
such as ‘type’ or ‘press’.

Type 100 in the cell to define 
the stream temperature, and 
press ENTER.
xix
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Bullets & Numbering
Bulleted and numbered lists are used extensively throughout the 
manuals. Numbered lists are used to break down a procedure into steps, 
for example:

1. Select the Name cell.

2. Type a name for the operation.

3. Press ENTER to accept the name.

Bulleted lists are used to identify alternative steps within a procedure, or 
for simply listing like objects. A sample procedure that utilizes bullets is:

1. Move to the Name cell by doing one of the following:
• Select the Name cell.
• Press ALT N.

Notice the two alternatives for completing Step 1 are indented to 
indicate their sequence in the overall procedure.

A bulleted list of like objects might describe the various groups on a 
particular view. For example, the Options page of the Simulation tab on 
the Session Preferences view has three groups, namely:

• General Options
• Errors
• Column Options

Callouts
A callout is a label and arrow that describes or identifies an object. An 
example callout describing a graphic is shown below.

 Figure 4

HYSYS Icon
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Annotations
Text appearing in the outside margin of the page supplies you with 
additional or summary information about the adjacent graphic or 
paragraph. An example is shown to the left.

Shaded Text Boxes
A shaded text box provides you with important information regarding 
HYSYS behaviour, guidelines, or alerts. Examples include:           

The use of many of these conventions will become more apparent as 
you progress through the manuals.

The resultant temperature of the mixed streams may be quite different 
than those of the feed streams, due to mixing effects.

Before proceeding, you should read the introductory section which 
precedes the example problems in this manual.

Annotation text appears in the 
outside page margin.
xxi
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Terminology
The following views show some of the HYSYS interface terminology:

• View. Any “windowed” graphical representation found on the 
HYSYS Desktop. Examples include the property view for a 
stream (such as Inlet Sep shown in Figure 6) or unit operation, 
or an error message window. (View and Property View are 
interchangeable.)

• Object Status Indicator. Found at the bottom of each property 
view, it shows the calculation status of the associated object. The 
indicator displays a status message with an appropriately 
coloured background (red for a missing parameter, yellow for a 
warning message, and green for OK).

• Scroll Bar. Clicking inside the scroll bar allows you to access 
information which cannot be displayed in the current size of a 
menu or view. The scroll bar in the above view is horizontal.

• Scroll Button. Clicking and dragging the scroll button up/down or 
left/right allows you to access information which cannot be 
displayed in the current size of a menu or view.

• Table. A group of cells in tabular format, through which you can 
manoeuvre with the mouse or the keyboard arrow keys.

 Figure 5

Property View Minimize/Maximize/Close icons

Table

An active cell always has a thick black border.

Notice the text colours that are used. Blue text 
indicates values that can be changed by you.

Black values are those calculated by HYSYS 
and cannot be changed.

Red values are those calculated by HYSYS 
and can be changed.

Object Status Indicator

Scroll Bar

Scroll 
Button
xxii
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• Input Cell/Field. A location inside a view where information is 
supplied and/or displayed. Examples include stream names, 
temperatures, etc. In some cases, an Input Cell/Field has an 
associated drop-down.    

• Tab. In views with multiple pages of information, such as property 
views and Workbooks, the pages are accessed by tabs at the 
bottom of the view. In the figure above, Design, Reactions, 
Rating, Worksheet and Dynamics are the tabs.

• Page. Most tabs have associated page views. These are listed in 
the column on the left side of the view. Above they are 
Connections, Parameters, User Variables and Notes.

• Button. Invokes a command when clicked. Buttons do NOT have 
any pictures on them. An example is the Delete button in the 
above view.

• Icon. Invokes a command when clicked. Icons have pictures on 
them (whereas Buttons do not). An example is the Minimize/
Maximize icons in the above view.

• Drop-Down List. A list of available options for a certain input cell, 
indicated by the arrow at the end of an input cell.

• Checkbox. Items or settings which are either On or Off. Placing a 
checkmark in a checkbox will turn the function On. Removing the 
checkmark turns it Off. The Ignored checkbox in the above view 
has no checkmark and is therefore Off.

• Unit Field. Provides a drop-down list of units which are 
applicable for the parameter type of the current input cell.

 Figure 6

Input cell or Field

GroupThis is the active Tab.

This is the 
active Page.

All available 
Pages are listed 
here.

Radio Button CheckboxButton
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• Group. An organizational border within a page that groups 
related functions together. 

• Radio Button. A set of options, of which only one can be active 
at a time. Radio buttons are always found in groups of at least 
two.

• Close icon. The X icon in the upper right corner of a view, used 
to close the view. 

• Minimize/Maximize icons. In the upper right corner of a view, 
allows you to iconize (minimize) the current view, or expand a 
view to its full size.

• Icon. A minimized view. Double-clicking on an icon opens the 
view. The HYSYS icon is shown to the left. When you double-
click, it opens HYSYS.

Now you’re ready to get started! 

HYSYS Icon
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xxvi Online Technical Support Center
Online Technical Support Center
AspenTech customers with a valid license and software maintenance 
agreement can register to access the Online Technical Support Center at 
http://support.aspentech.com. 

The support Web site allows you to:

• Access current product documentation
• Search for tech tips/solutions/frequently asked questions (FAQs)
• Search for and download application examples
• Search for and download service packs and product updates
• Submit and track technical issues
• Search for and review known limitations
• Send suggestions

Registered users can also subscribe to our Technical Support e-Bulletins. 
These e-Bulletins are used to alert users to important technical support 
information such as:

• Technical advisories
• Product updates
• Service Pack announcements
• Product release announcements
xxvi
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Contacting Technical Support
Technical support is available by phone, fax, and e-mail for customers 
with a current support contract for their product. For the most up-to-
date phone listings, please see the Online Technical Support Center at 
http://support.aspentech.com.

When contacting us via e-mail, please include in your message:

• Your full name, company, phone and fax numbers.
• The software version you are using (shown in the Help menu, 

About...).
• The serial number of your security key, if you have an installation, 

security, or network issue.
• A detailed description of the problem (attach a simulation case if 

possible).

We also have toll-free lines that you can use. When you call, please have 
the same information available. 

Support Center Hours
Support Centers Operating Hours

North America 8:00 - 20:00 Eastern Time

South America 9:00 - 17:00 Local time

Asia and Pacific Region 9:00 - 17:30 Local time

Europe, Middle East, and Africa (EMEA) 8:30 - 18:00 Central Europe time
xxvii
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Support Center Phone Numbers
Support Centers Phone Numbers

North America +1 888 996 7100 (Toll-free from U.S., Canada, Mexico)

+1 281 584 4357 (From outside U.S., Canada, Mexico)

+52 55 5536 2809 (Mexico Support Center)

South America +54 11 4590 2254 (Argentina Support Center)

+55 11 5012 0321 (Brazil Support Center)

+0800 333 0125 (Toll-free to U.S. from Argentina)

+000 814 550 4084 (Toll-free to U.S. from Brazil)

+0800 100 2410 (Toll-free to U.S. from Venezuela)

Asia and Pacific Region +81 3 3262 1743 (Tokyo, Japan)

+65 6395 39 00 (Singapore)

Europe, Middle East, 
and Africa (EMEA)

+32 2 701 95 55 

If you are calling from one of the countries listed below, you 
can dial your in-country toll-free number:

Country Toll-free Number

Austria 0800-111-900

Belgium 0800-40-687

Denmark 8088-3652

Finland 0-800-1-19127

France 0805-11-0054

Germany 0800-101-0068

Ireland 1-800-930-024

Italy 800-905-826

Netherlands 0800-023-2511

Norway 800-13817

South Africa 0800-996-852

Spain 900-951846

Sweden 0200-895-284

Switzerland 0800-111-470

UK 0800-376-7903
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Fax Numbers

E-mail Addresses

Support Centers Fax Numbers

North America +1 281 504 3999

South America +54 11 4590 2236 (Argentina)

+55 11 5012 4442 (Brazil)

Europe +32 2 701 94 45 

Asia and Pacific Region +65 6395 39 50 (Singapore)

+81 3 3262 1744 (Tokyo)

Support Centers E-mail

North America esupport@aspentech.com 

South America Lasupport@aspentech.com

Europe, Middle East, and 
Africa 

esupport@aspentech.com 

Asia and Pacific Region esupport@aspentech.com 
xxix
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xxxii Training Contact Information
Training Contact Information
If you are interested in attending a course or want more information 
about course contents, please contact the training coordinator for your 
region. Please direct all e-mail to training.registration@aspentech.com.

If you have sales-related questions, would like specific industry 
information or need assistance with purchasing AspenTech products, 
please complete the on-line form or call our eSales office in the US at 1-
281-584-1945.

North and South America
Telephone (toll-free): + 1-888-996-7100, menu option 7

Telephone (outside North America): + 1-281-584-4357, menu option 7

Fax: + 1-281-584-1064

E-mail: training.registration@aspentech.com

Europe
Telephone: +32-2-7019555, menu option 7

Fax: +32-2-7019570

E-mail: atetraining@aspentech.com 

If you are calling from one of the Western European countries listed 
below, you can dial your in-country toll-free number to reach 
AspenTech Support & Training:

Country Toll-free Number

Austria 0800-111-900

Belgium 0800-40-687

Denmark 8088-3652

Finland 0-800-1-19127

France 0805-11-0054

Germany 0800-101-0068

Ireland 1-800-930-024
xxxii
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South Africa
Telephone: + 27-11-258-8780 

Fax: + 27-11-258-8558

E-mail: susan.brown@aspentech.com 

Japan
Telephone: + 81-3-3262-1743 

Fax: + 81-3-3262-1744

E-mail: atjtraining@aspentech.com

Asia and Australia
Telephone: + 65-6395-3900

Fax: + 65-6395-3950

E-mail: atatraining@aspentech.com

Italy 800-905-826

Netherlands 0800-023-2511

Norway 800-13817

South Africa 0800-996-852

Spain 900-951846

Sweden 0200-895-284

Switzerland 0800-111-470

UK 0800-376-7903

Country Toll-free Number
xxxiii
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1-2 Basic Requirements
1.1  Basic Requirements

1.2  Licensing Information
You need a license file and hardware security key to run HYSYS. Refer to 
the SLM Installation and Reference Guide for detailed information on 
licensing. 

System Component Requirements

Operating System Microsoft Windows 2000/XP

Microsoft Internet Explorer version 5.0 or higher.

Processor Speed Pentium II 400 MHz, recommended PIII 700 MHz or better.

RAM requirements Minimum 128 MB RAM, recommended 256 MB.

Total Memory (RAM + Virtual Memory) minimum 300 MB, 
recommended greater than 300 MB

Disk Space Minimum 200 MB of free disk space.

Serial Port The green security dongle is used with the standalone version 
of HYSYS and can only be attached to a serial communications 
port of the computer running the application (do not plug in a 
serial mouse behind the security dongle).

Parallel/USB Ports SLM dongles are Sentinel SuperPro - Computer ID dongles, 
manufactured by Rainbow Technologies. The Computer ID 
dongle is installed on the parallel port (printer port) of your 
computer. An arrow indicates which end should be plugged to 
the computer. This is the new dongle that is used for both 
Standalone and Network versions of HYSYS.

Monitor/Video Minimum usable: SVGA (800 x 600).

Recommended: SVGA (1024 x 768).

Mouse Required. Note that a mouse cannot be plugged into the back 
of the green serial port dongle used with the “standalone” 
version of HYSYS.
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1.3  Upgrading from Older Versions 
of HYSYS

HYSYS 2.2.2 & Older
If you are using a standalone copy of HYSYS, your green serial port key 
will continue to work with your old version of HYSYS; it will also work 
with all SLM versions of HYSYS (v2.4 and on) so long as you have 
properly installed your license file.

Network copies of HYSYS 2.2.2 will not function with your new SLM 
network key and license server. Only copies of HYSYS version 2.4 and 
newer will operate with the SLM licensing system.

HYSYS 2.4 & Newer Versions
These versions of HYSYS already use the SLM licensing system. You may 
need to install a new license file (if so, one will be supplied). Otherwise, 
install the HYSYS software and continue using the existing licenses.

If you are using commutable licenses, please ensure that there are no 
commuted HYSYS licenses on your computer before proceeding with 
the upgrade.*

* For more information, contact your AspenTech sales agent.

The old network key can not be installed on the same computer as the 
new SLM network key. Please uninstall your old network key and key 
server software (procedure varies, consult the Get Started manual from 
the older HYSYS version for details) before installing the SLM license 
server.
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1.4  Installing HYSYS
The following instructions are written assuming installation on 
Windows 2000/XP.

1. Shut down all other programs on the computer before starting the 
installation process.

2. Insert the HYSYS software CD in the CD drive of your computer.    

3. From the Start menu, select Run.

4. In the Run view, type: d:\setup.exe and click on the OK button 
(where d: is your CD drive).

5. The following installation screen appears.     

6. Click on the Install Products link.

For computers which have the CD-ROM Autorun feature enabled, steps 
#3 and #4 will be automatically performed.

 Figure 1.1 
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7. On the Products view, select HYSYS. The Installation Wizard may 
take a few moments to load. The Welcome view appears.

8. Read the information and click the Next button. The Customer 
Information view appears.

Enter your name and company information in the fields. 

Select one of the radio buttons to determine whether HYSYS should 
be available to anyone else who logs on to your machine, or if it 
should be available only to you when you log on to your machine. 

9. Click Next. The Destination Folder view appears.

This view displays the default location on where the HYSYS program 
is going to be placed on your machine.

C:\Program Files\Hyprotech\HYSYS 3.2\

To change the location of the program, click the Change button, 
enter or select the new location for the HYSYS program in the Folder 
Name field on the Change Current Destination Folder view, and 
click the OK button.

10. Click Next. The Setup Type view appears.

There are two setup types for installing HYSYS. Select the setup type 
you want by clicking the appropriate radio button:

• Complete. Installs the entire HYSYS program, including the 
example files, extension SDK, Sizing, and SLM Client Tools.

• Custom. Open the Custom Setup view and allows you to select 
which options/features you want to install with the HYSYS 
program.

11. Click Next. The Ready to Install the Program view appears. 

12. Review your settings here: click Back to change your settings, or 
click Install to continue. HYSYS will then begin installing files to 
your computer.

13. In the Installing HYSYS view, you can see the progress of the 
installation. Once installation is done, the Installshield Wizard 
Complete view appears. 

14. Read the information on this view and click the Finish button. 

It is recommended that you restart your computer.

If you experience any 
difficulties, refer to Chapter 
10 - Troubleshooting SLM 
Problems in the SLM 
Installation and Reference 
Guide.
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1.4.1  HYSYS Installation to an Application 
Server

Installing HYSYS onto a server follows exactly the same process as 
outlined in the previous section. Simply choose a network drive instead 
of the local drive when on the Select Components view. Then each of the 
client workstations must be set up as detailed below. To prevent 
accidental modification or deletion of files, it is recommended that 
HYSYS users be allowed read-only access to the HYSYS software. Each 
HYSYS user should then configure an individual preferences file and 
store that file on their local hard disk (or write-enabled network drive).

To set up each of the client workstations:

1. Ensure that the workstation has all of the required components for 
running HYSYS using the SLM (see section Technical Support for 
information on how to contact AspenTech for help); you can install 
missing components by running the files found on the Software CD 
in the OS Upgrades folder.

2. Copy the strgxi2.dll from the computer where HYSYS was installed; 
this file must be on every client workstation for them to work 
properly. You may want to copy the entire Hyprotech common files 
folder (C:\Program Files\Common Files\Hyprotech\) including all 
of its sub-folders onto each workstation as this will ensure that each 
user also has access to the SLM troubleshooting tools.

3. Register the strgxi2.dll; i.e., use the DOS command line or select 
Run from the Windows Start button.

regsvr32 “C:\Program Files\Common 
Files\Hyprotech\Shared\strgxi2.dll” 

Regsvr32.exe is installed in the HYSYS root directory.

4. Create a working directory for HYSYS on the workstation (i.e., 
C:\Program Files\Hyprotech\HYSYS\). In this directory, create the 
sub-directories CASES, PAKS, and USER.

5. Create a shortcut to HYSYS.exe (on the desktop or in the Start 
menu). In the shortcut Properties, set the Start In directory to the 
working directory you created in the previous step.

If it is necessary to move the common files to another machine, copy 
C:\Program Files\Common Files\Hyprotech\ to the drive you want to 
move the common files.

It is recommended that all 
components on C:\Program 
Files\Common 
Files\Hyprotech are installed 
and registered.

You should register all DLL 
and OCX.
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COMThermo

For COMThermo, the following keys must be created in the registry:

• HKLM\Software\Hyprotech\COMThermo\DatabasePath - 
contains the path to COMThermo\Databases.

• HKLM\Software\Hyprotech\COMThermo\ModelsPath - contains 
path to COMThermo\Models.

• HKLM\Software\Hyprotech\COMThermo\Version - contains 
version number of COMThermo (version number can be found in 
any of the COMThermo DLLs and is used by the applications to 
display the COMThermo version information in the Help About 
box).

BaSYS

If you have BaSYS installed, you have to register all OCX and DLL.

XML

If you have XML, you have to register the XMLRead.dll, however this dll 
is optional.

MSXML4

The MSXML4.msi is available on the software CD. If you already have 
the XML parser installed on your computer you don’t have to install the 
MSXML4.msi file.

If you install MSXML4.msi then you have to register the 
[INSTALLDIR]hyphys.dll.

System DLLs (fortran runtime)

The following are DLLs that are required especially for COMThermo:

• Msfrt40.dll
• Dformd.dll
• Dforrt.dll

There are a number of other system DLLs that may be installed, however 
it is difficult to get a list of the DLLs as they are in merge modules.
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1.4.2  Setting HYSYS File Location Preferences
To set your HYSYS file location preferences:

1. Start HYSYS. 

2. From the Tools menu, select Preferences. The Session Preferences 
view appears.

3. On the Files tab, select Locations.

4. Configure the Default Files and Paths as shown below. These are 
suggestions only and some modification may be required. 

5. Click the Save Preference Set button, and save it to the HYSYS 
working directory on the local disk.

 Figure 1.2
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2-2 Starting HYSYS
The Getting Started section gives a quick introduction to HYSYS by 
recalling a saved case and illustrating how to navigate through HYSYS.

2.1  Starting HYSYS
To start HYSYS: 

1. Click on the Start menu in Windows.

2. From the Programs menu, select Hyprotech then HYSYS 3.2.

3. Select HYSYS. HYSYS begins to load.

Now you are ready to begin working with HYSYS. The HYSYS Desktop is 
the first thing you will see:

 Figure 2.1

HYSYS Icon

Minimize/Maximize/Close iconsMenu bar Toolbar Desktop

Trace Window
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Before opening the pre-built Getting Started case, you should choose 
the HYSYS unit set used for displaying information. You can check your 
current unit set by accessing the Session Preferences from the menu 
bar:

1. From the Tools menu, select Preferences. The Session Preferences 
view appears. 

2. Click on the Variables tab. The Units page should be open by 
default. The Current Unit Set is shown highlighted in the list of 
Available Unit Sets. The HYSYS default is SI; however the Getting 
Started example has been developed in Field units.

3. Click on Field to make it the current unit set.

4. Click the Close icon to close the Session Preferences view.

This view has been resized; your Desktop view should appear larger 
than this when initially opened. To re-size the view, click and drag the 
outside border. To make the view full size, click the Maximize icon in the 
upper right corner.

 Figure 2.2

The default unit set is SI.

This Close 
icon is found 
on every 
view.

Click on the Variables tab 
to access the Units page. 
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Recalling the Simulation Case from Memory
Included with your HYSYS package are a number of pre-built simulation 
cases located in the Samples subdirectory of the HYSYS root directory. 
One of these cases is named gstrt-ss.hsc and is the example used here. 
To load the case:

1. Do one of the following:
• Click the Open Case icon on the toolbar.
• From the File menu, select Open then Case.
• Press CTRL O.

The Open Simulation Case view appears.

2. Open the Samples subdirectory and scroll through the list of files 
until gstrt-ss.hsc is visible.

 Figure 2.3

Open Case icon
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3. Click on gstrt-ss.hsc, then click the Open button. The pre-built 
simulation case appears on your Desktop.

Saving the Case Under a New Name
Before working with this case, you should save it using a new name to 
ensure that the original file remains intact.

1. Do one of the following:
• From the File menu, select Save As.
• Press CTRL SHIFT S.

The Save Simulation Case As view appears.

 Figure 2.4
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2. Type a new name, for example MYCASE, in the File name field. Note 
that you do not have to enter the .HSC extension; HYSYS will add it 
automatically.

3. Click the Save button, and HYSYS saves your case with the new 
name.

 Figure 2.5
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2.2  Steady State Case
This steady state simulation models the production of propylene glycol. 
Using a continuously-stirred-tank reactor (CSTR), propylene oxide and 
water are reacted at atmospheric pressure. The reaction is exothermic, 
so a coolant is circulated to the reactor to maintain its temperature. The 
reactor effluent, consisting of propylene glycol and unreacted feed, is 
fed to a distillation column. In the column, 99.5 mol% glycol is produced 
from the bottoms, while unreacted propylene oxide and water are 
recovered overhead.

Three windows, or views, are currently displayed on the HYSYS 
Desktop. Each view is identified by its title at the top of the view. The 
current active view is the PFD, which is a graphical representation of the 
process flowsheet.

The Steady State - Dynamic 
toggle on the toolbar indicates 
that you are currently in 
Steady State mode.

 Figure 2.6

Maximize icon

Properties table for Reactor Prods.Zoom All icon

Unit operation icon for a CSTR reactor. Stream icon

The PFD has its 
own toolbar.
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The PFD shows:

• The streams and unit operations, represented by symbols (called 
icons), in the flowsheet.

• The connectivity amongst the streams and unit operations.
• A property table for the Reactor Prods stream.

If you want, you can re-size the PFD view to make it more readable.

1. Do one of the following:
• Click and drag the outside border to the new size.
• Click the Maximize icon in the upper right corner of the view.

2. Click the Zoom All icon to zoom-in on all items in the PFD, filling 
the resized view.

You can display summary information for a particular object (stream or 
operation) simply by placing the cursor over the object’s icon. For 
example, position the cursor over the icon for stream Prop Oxide. A fly-
by view appears at the cursor tip, showing the stream temperature, 
pressure and molar flow.

Accessing Stream Information from the PFD
Every stream and operation (object) contained in a HYSYS simulation 
has its own property view, which contains multiple tabs and related 
pages of information or properties describing the object. You can access 
the property view for a stream directly from the PFD by simply double-
clicking on the stream icon.

Stream Fly-By

For detailed information on the 
information in this section, see 
Chapter 3 - Streams in the 
Operations Guide.
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For example, to see the property view for one of the streams entering the 
reactor, double-click on the Reactor Vent icon on the PFD. The property 
view for the Reactor Vent appears as shown in the figure below. 

When an object’s property view is initially opened, it displays the first 
page on the first tab of the view. For the Reactor Vent property view, the 
first tab is the Worksheet tab; its first page is the Conditions page. Tabs 
are listed along the bottom of an object’s view. Each tab has associated 
pages that are listed in the column on the left side of the view. Change 
the page or tab by clicking on the page or tab. 

Conditions Page

The Conditions page of the Worksheet tab gives the basic conditions of 
the stream: the vapour fraction, temperature, pressure, material flows 
and heat flow (enthalpy).

Properties Page

The Properties page of the Worksheet tab displays all the Transport 
Properties for each stream phase. You can manipulate the properties 
displayed on this page for an individual stream. The properties from the 
Conditions page are not available for this page.

 Figure 2.7Reactor Vent Icon

Conditions, Properties, 
Composition, Notes 
and K Value are all 
pages associated with 
the Worksheet tab.

Property view tabs are 
listed along the bottom.

You can manipulate the 
Property page for all streams, 
by using the Correlation 
Manager.

Refer to Section 11.18 - 
Correlation Manager in the 
User Guide for more 
information about the 
Correlation Manager.
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Composition Page

The Composition page of the Worksheet tab displays the material 
composition of the stream. In this case, five components are displayed 
along with the liquid volume flow for each component. You can display 
the composition on another basis, such as mass or molar fraction, by 
clicking the Basis button.

 Figure 2.8

Basis 
button.
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K Value Page

The K Value page of the Worksheet tab displays the K values or 
distribution coefficients for each component in the stream.

Electrolytes Page 

The Electrolytes page of the Worksheet tab displays true species phase 
properties and compositions of an electrolyte stream.

 Figure 2.9

In this case, there are no electrolytes being used, so an Electrolytes 
page does not exist. Shown below is only an example of the Electrolytes 
page.

The Electrolytes page is only 
available if the stream is in 
an electrolyte system.

Refer to Section 1.2.4 - 
Adding Electrolyte 
Components in the 
Simulation Basis manual 
for more information about 
electrolytes.
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This page contains two radio buttons for phase selection: 

• Aqueous 
• Solid 

There are two radio buttons corresponding to each phase selection:

• Properties 
• Composition 

The following are the combination views for the selection of the radio 
buttons under Phase and True Species Info groups.

* It is a measure of the tendency of a solid species forming at the specified stream conditions. 
Solids with a scale tendency index greater than one will form if the solid formation is governed 
by equilibrium (as opposed to kinetics) and if there are no other solids with a common cation or 
anion portion which also has a scaling tendency greater than one. If more than one solid exists 
with a common ion and scaling tendency greater than one, then at least one will form. You can 
use scaling tendencies to learn more about which solid can safely be deleted from the model.

 Figure 2.10

Phase True Species Info Display

Aqueous Properties Aqueous phase related properties like pH value, Osmotic 
Pressure and Ionic Strength.

Composition The concentrations calculated on ionic basis. The real ionic 
species from the aqueous phase are also shown.

Solid Properties Scale tendency* value for each solid in the lists. User can choose 
to include or exclude the solid component in the list for the stream 
thermo flash by checking the Include checkbox.

Composition Concentrations that are the same as in the traditional stream 
phase view. But the solid component list indicates if the solid 
component is a precipitate or a hydrate. 

The Electrolytes 
page is only visible 
when an 
electrolytes case is 
loaded.
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User Variables Page

The User Variables page of the Worksheet tab allows you to write and 
attach code as a User Variable to extend the functionality of your 
stream. 

Once you have finished examining the stream properties, close the view 
using the Close icon in the upper right corner of the view. The next time 
you open the property view, it will open to the last page that you 
accessed before closing the view.

Cost Parameters Page

You can enter a cost factor value for the stream in the Cost Parameters 
page of the Worksheet tab. You can also choose the flow basis associated 
with the cost factor from the Flow Basis drop-down list.

 Figure 2.11

Close icon

For more information 
regarding cost parameters 
refer to the Sizing manual.
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The remaining property view tabs and their associated pages are 
explained below.

Attachments Tab

The Attachments tab consists of the following pages:

• Unit Ops Page. Lists the unit operation(s) to which the stream is 
attached.

• Utilities Page. Allows you to create and attach utilities to the 
stream.

• DRU Stream Page. Allows you to add a transfer stream.

 Figure 2.12
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Dynamics Tab

The Dynamics tab consists of the following pages:

• Specs Page. Applicable only in Dynamics mode. You activate 
dynamic specifications on this page.

• Stripchart Page. Provides an automatic way to create a strip 
chart for monitoring stream variables while running in Dynamics 
mode.

 Figure 2.13
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Using the Workbook to Change a Stream Temperature
Click the Workbook icon on the HYSYS toolbar to change the current 
view to the Workbook.

The Workbook view displays tabular information pertaining to the 
streams and unit operations in the simulation. You can also add, delete 
or modify streams and unit operations in the Workbook. The first tab of 
the Workbook, Material Streams, displays for each stream the same 
information that is available on the Conditions page of the stream 
property view. You can view the streams that are not currently visible by 
re-sizing the view, or by clicking repeatedly on the vertical scroll arrow.

The remaining Workbook tabs include:

• Compositions. Displays the composition of each material 
stream.

• Energy Streams. Displays the name and heat flow of each 
energy stream.

• Unit Ops. Lists summary information for all unit operations.

 Figure 2.14

Workbook icon

Lists the unit operations to 
which the stream is attached.

The temperature 
of Reactor Prods 
is currently 
135oF.
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Suppose you want to investigate the amount of cooling required to 
maintain the reactor at certain temperatures. The reactor is currently 
operating at 135oF, which is the temperature of the product Reactor 
Prods (as shown in the previous figure).

To see the cooling requirement to achieve this temperature, move to the 
Energy Streams tab in the Workbook.

The cooling duty required to maintain the specified reactor temperature 
is 4.8 MMBtu/hr, the Heat Flow of the energy stream Coolant. Check the 
cooling requirement for outlet temperatures of 100oF. The reactor 
temperature is set by the specification on the outlet stream Reactor 
Prods. 

To specify the new separator temperature:

1. Return to the Material Streams tab in the Workbook by clicking on 
the tab.

2. Select the temperature cell for the Reactor Prods stream.

 Figure 2.15

The reactor cooling requirement is 
represented by the Heat Flow of 
the stream Coolant.

Click here to move to the 
Energy Streams tab of 
the Workbook.

Workbook values shown in 
blue are user-specified. 
Values in black are calculated 
by HYSYS.
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3. Type 100, the press ENTER. HYSYS will automatically re-calculate the 
Flowsheet based on the new temperature.

4. Return to the Energy Streams tab to see the re-calculated cooling 
requirement.

The temperature change has decreased the required cooling duty to 4.4 
MMBTU/hr.

Suppose you want to examine the cooling duty at a number of other 
temperatures. Instead of repeating the above procedure for each new 
temperature, the HYSYS Case Study feature will automatically make 
changes and tabulate the results for you. 

 Figure 2.16

 Figure 2.17

Enter 100 in the Temperature 
cell for Reactor Prods.

You might expect the cooling 
requirement to increase as 
the reactor temperature is 
lowered. However, the 
reaction has two attributes 
that dominate the reactor’s 
heat balance:

1. The reaction produces 
heat proportional to the 
amount of reaction 
occurring.

2. Less reaction occurs at 
100oF than at 135oF.

So by lowering the reactor 
temperature, less reaction is 
taking place and less heat is 
produced by the reaction. 
Therefore, less cooling is 
required.
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Using the Case Study
The third view open on your Desktop is the Case Studies view. To access 
this view:

1. From the Window menu, select Case Studies -Main. 

The three views that are currently open on the Desktop are listed at 
the bottom of the menu. A checkmark indicates the view that 
currently has focus. In this case, it is the Workbook view. 

2. The Case Studies view appears as shown in the figure below.

The Case Studies view shows a plot of the separator cooling duty and the 
Glycol stream molar flow rate (dependent variables) versus the 
separator temperature (independent variable).

Case Study 1 has been configured to calculate and plot values over an 
independent Temperature range of 75°F to 130°F with an increment of 
10°F. You may actually want to observe the results over a wider range. 

 Figure 2.18
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To change the bounds of the independent variable for the case study:

1. Click the Setup button on the Case Studies view. The Case Studies 
Setup view appears.

Leave the Low Bound at its value of 75°F, and the Step Size as 10°F. 

2. Change the High Bound value to 215°F. 

3. Click the Start button.

4. Click the Results button. 

HYSYS begins calculations immediately, solving the Flowsheet at each 
temperature and plotting the results on the Case Studies view. When the 
Flowsheet has been solved at the final temperature of 215°F, 
calculations will stop automatically. 

 Figure 2.19
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The final Case Studies view is shown in the following figure.

The Case Study shows that the cooling requirement increases to its 
maximum value at approximately 125°F and then decreases, while the 
glycol production rate increases over the entire temperature range.

You have now completed your first HYSYS steady state simulation! You 
can save your case by doing one of the following:

• Click on the Save icon on the toolbar.
• From the File menu, select Save.
• Press CTRL S.

You are now free to explore this case on your own. If you want, you can 
continue on with the Dynamics Case in the next section, or quit HYSYS 
by doing one of the following:

• From the File menu, select Exit.
• Click the Close icon in the right corner of the HYSYS desktop.

 Figure 2.20

Save icon
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If you have made any changes to your case since the last time it was 
saved, HYSYS will prompt you to save before exiting.

2.3  Dynamics Case
The previous steady state section of this example continues with the 
addition of a reactor control scheme in dynamics mode. To open the 
case:

1. Do one of the following:
• Click the Open Case icon on the toolbar.
• From the File menu, select Open then Case.
• Click CTRL O.

The Open Simulation Case view appears.

2. Open the Samples directory. Scroll through the list of files until 
gstrt-dy.hsc is visible.

3. Click on gstrt-dy.hsc, the click Open. The pre-built simulation case 
opens on the Desktop.

This case has been set up to 
run without any 
modifications from the 
dynamic assistant. However 
everything will still work if the 
changes are made.

The dynamic assistant can 
be toggeled on/off in the 
preferences found under the 
Tools menu.

Open Case icon
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As with the steady state case, you should save this case under a new 
name before making any changes.

4. Do one of the following:

• From the File menu, select Save As.
• Press CTRL SHIFT S.

The Save Simulation Case As view appears.

 Figure 2.21

Face plates Integrator
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5. Type a new name, for example MYCASE2, in the File Name field. 

6. Click the Save icon, and HYSYS saves the simulation case under its 
new name.

This case is a dynamic model of the propylene glycol reactor from the 
steady state portion of the example. The PFD shows the control scheme 
for the reactor, which includes the following three controllers: 

The face plates for these three controllers are open along the top of the 
Desktop. The face plates components are listed in the following table: 

The face plate for the Reactor LC (level controller) is shown below: 

You do not have to enter the .hsc extension; HYSYS will add it 
automatically.

Controller Action

Reactor LC Controls the liquid level in the reactor by manipulating the reactor 
outlet flow.

Reactor TC Maintains the reactor temperature by manipulating the coolant flow.

Glycol Conc Controls the concentration of propylene glycol in the reactor outlet 
stream by manipulating the flow of the propylene oxide feed.

Face Plate Field Description

PV Cell The PV cell shows the current value of the Process Variable, or 
controlled variable. For example, the PV for the Reactor LC is the 
percent liquid level in the reactor. The current Set Point for the 
Process Variable is indicated by the red pointer on the top of the 
PV cell.

OP Cell The OP cell displays the current value of the controller Output as a 
percentage.

Controller Mode 
Drop-Down

Provides a drop-down list of the available controller modes. 
Currently, two of the controllers are in Automatic mode and the 
third is in Manual mode.

 Figure 2.22

If the PFD is not open, you 
can open it by clicking the 
PFD icon on the toolbar.

PV cell.

OP cell.

Set Point 
indicator.

Drop-down for 
controller modes.
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In addition to the PFD and controllers, two other views appear on the 
desktop. They are:

• The Integrator, which lets you to start and stop dynamic 
calculations.

• The Reactor Key Variables view that is currently behind the PFD. 
To display this view, click on its title bar. The view is a customized 
HYSYS Strip Chart, on which the values of selected key variables 
will be plotted during dynamic calculations.

In Dynamics mode, HYSYS performs flowsheet calculations with each 
time step. Currently, the Step Size is 0.5 seconds, so HYSYS will perform 
flowsheet calculations for every 0.5 seconds of real plant time.

In this example, the CSTR reactor will be set up from an empty 
condition using the following procedure:

1. Fill the vessel with water until the level set point is reached, at which 
time the Reactor LC controller will open the outlet control valve to 
maintain the level.

2. Slowly introduce propylene oxide into the reactor while observing:

• The Reactor TC controller maintaining the reactor temperature.
• The concentration of propylene glycol in the product stream.

3. Switch the Glycol Conc controller to automatic mode to maintain 
the product concentration at a specified set point.

Starting Dynamic Calculations
Switch to dynamics mode by clicking the Dynamics mode icon on the 
toolbar. HYSYS will indicate that the Dynamics Assistant has identified 
items that need attention, click No.

Ensure that the Reactor Key Variables view is visible by clicking on its 
title bar. To begin, click the Start button on the Integrator. HYSYS will 
again indicate that the Dynamics Assistant has identified items that 
need attention, click No.

The reactor will begin to fill and the values of the process variables will 
immediately be displayed on the controllers and plotted on the strip 
chart. When the Current Time reaches about 55 minutes, click the Stop 
button.

You can also start and stop 
dynamic calculations using 
the Integrator toggle icons in 
the toolbar.

The green icon (left) starts 
the integrator. The red icon 
stops it.

Dynamics mode icon
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Notice that the reactor level rises linearly as the vessel fills to its set point 
of 85%.      

Click the Continue button on the Integrator. As the reactor level 
approaches its set point, the Reactor LC controller will open the outlet 
valve to maintain the level. When the current time reaches 
approximately 125 minutes, click Stop and view the results.

 Figure 2.23

The Current Time displays 
the real plant time.

The rising vessel level is plotted on the 
Strip Chart and displayed in the PV cell of 
the Reactor LC controller.

To check the current level set point, place the cursor over the 
Set Point Indicator. When the cursor changes to a double-
headed arrow, left-click and hold.

Coolant rateProduct 
temperature

If you want to reset dynamic calculations, click the Reset button on the 
Integrator. Then click the Start button to restart the calculations from 
zero. HYSYS will ask for confirmation before resetting the values.
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Adding a Process Disturbance
Click the Continue button of the Integrator. When the reactor level and 
product volume flows reach a steady state value, at about 200 minutes, 
click Stop. To add the disturbance, introduce some propylene oxide into 
the reactor by doing the following:

1. Double-click on the OP cell on the Glycol Conc controller face plate.

2. Type 25, then press ENTER. The control valve for the propylene oxide 
feed will open 25%.

3. Note the Current Time displayed on the Integrator.

4. Start the Integrator again.

5. After the Current Time has increased by about 70 minutes, stop the 
Integrator.

As a result of the disturbance:

• The reactor temperature increases due to the exothermic 
reaction. The reactor coolant will increase in flow to maintain the 
reactor temperature at 110°F.

• The outlet flow increases to maintain the reactor level because of 
the increased feed.

• The propylene glycol begins to appear in the product stream.
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If you want, start the Integrator again and try entering other values for 
the OP, such as 40 or 50%, and watch the response.

The next step is to switch the composition controller Glycol Conc to 
automatic mode and let it maintain a concentration set point. Use a set 
point of 0.25 mole fraction propylene glycol. Before changing the set 
point, stop the Integrator again. 

 Figure 2.24

Increase in reactor 
outlet flow.

Increase in cooling requirement 
due to the reaction.

Propylene glycol concentration at 3.7%.
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To change the set point follow the procedure outlined below:  

After you have entered the new set point, start the Integrator again. The 
system will react to the new set point as follows:

• The flow of propylene oxide feed increases because the 
composition controller wants to raise the concentration of glycol 
in the product stream.

• The reactor level rises as a result of the higher feed rate; the 
product flow therefore increases to maintain the level set point.

• The reactor temperature rises because more exothermic reaction 
is taking place, and the coolant flow increases to compensate for 
this temperature change.

 Figure 2.25

Alternatively, you can enter 
an exact set point by typing 
the value in the PV cell, then 
pressing the ENTER key.

Click on Auto in the 
drop-down list to 
change the controller 
mode.

Place the cursor 
over the set point 
indicators, and the 
cursor will change 
to this double-
headed arrow.

With the double-headed 
arrow visible, click and hold. 
This white box will appear, 
displaying the current set 
point value.

Click and drag to “slide” the 
set point to the right. The set 
point value will change as 
you drag. Release the left 
mouse button when you 
reach the new set point.

Open the drop-down 
list of controller 
modes by clicking on 
this arrow.

If you want at any time to 
reset dynamic calculations 
and begin filling the vessel 
again:

1. Click the Reset button.

2. Return the Glycol Conc 
controller to Manual 
mode.

3. Enter a value of 0 in the 
OP cell of the Glycol Conc 
controller.

4. Click the Start button.
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Feel free to experiment by changing either of the other set points and 
watch the response. When you are finished, stop the Integrator.

You have now completed your first dynamic simulation using HYSYS! 
Before moving on, you can save your case by doing one of the following:

• Click the Save icon on the HYSYS toolbar.
• From the File menu, select Save.
• Press CTRL S.

 If you want, you can quit HYSYS by doing one of the following:

• From the File menu, select Exit.
• Press ALT F4.
• Click the Close icon in the right corner of the HYSYS desktop.

If you have made any changes to your case since the last time it was 
saved, HYSYS will prompt you to save before exiting.

 Figure 2.26

More propylene glycol starts 
appearing in the product stream.

Coolant flow increases to accommodate for 
the extra heat introduced by the reaction.

Save icon
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This concludes the Getting Started example. You are encouraged to 
proceed to the HYSYS Tutorials & Applications manual. The Tutorial 
problems provide a more in-depth look at HYSYS by guiding you step-
by-step through a number of example simulations. Both steady state 
and dynamic tutorials are available.
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